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EXECUTIVE SUMMARY

This White Paper provides detailed information about how to migrate multiple user
mailboxes from IBM Domino/Notes (NSF) to Google G Suite (Apps/Gmail).

It contains recommendations about preparing the Source and Target message
platforms/servers to ensure the proper permissions are in place, and thus
eliminating the reliance on individual user passwords.

It also provides in-depth information about specific features that alter the default
behavior of Transend Migrator, and identifies best practices that enhance
migration efficiency.

Step-by-step instructions detail how to configure the tool and perform the
migration from beginning to end.

Need more help?

If you can’t find the information you seek, please view the Help File, which contains
the most detailed information about every feature within the tool, including
additional best practices.

Please also contact us directly to get answers to your questions, as well as inform
us of what’s missing in this White Paper — we’re always looking for ways to improve
our offering, and documentation is an important piece of the puzzle.
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IBM Domino/Notes (NSF) = Google G Suite
Technical Reference Guide

Section 1: Introduction

This Technical Reference Guide details how to perform a batch migration of the following data types
using Transend Migrator:

» Email Messages/Folders » Calendar Entries
> Address Books » Tasks/To Do Items

For more detailed information about your specific application, security requirements, and additional
migration options, please review the Help File. The Transend Migrator Help File is context sensitive.
Selecting a help button will take you to the specific section in the Help File related to the screen you are
in.

Section 2: User Interface Overview

Transend Migrator contains an easy to use interface, designed to simplify the migration experience
while allowing for maximum flexibility. Setting up your project to convert E-mail, Address Books,
Calendars, and Tasks is accomplished within one user interface allowing you to quickly complete your
migration in one run.

Menu Bar
The Menu Bar is where you will make your data type selections. The top level Menu is where you will

find additional commands for saving configurations, setting various migration options, setting and
viewing logging and reporting options, and setting up batch migrations for multiple users.

.\\ﬁ Transend Migrator - C\ProgramData\ Transend\ default.trd E' [=] @
File Migration Qpticns  Batch Migration View  Edit License Help

ﬁ’ﬁ\ . =
{_“E_’f’.\}\/ E-Mail ‘ g\/ Address Book 5%-"/ Calendar w=|w’ Task/To Do
N ey J
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User Interface
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The same interface is used whether you are migrating a single user mailbox or multiple user mailboxes
at once (Batch Mode). Each screen for E-mail, Address Book, Calendar, or Task/To Do items is similar.
Differences relate to the specific item types. The Email Configuration screen is shown below.

.\\ Transend Migrator 12 - C\ProgramData\Transend\default_v12.tmd

S

File Migration Options Batch Migration View Edit License Help 1

Address Book
g 2
Advanced Options...

From: |Domin0,-’N0tes,-’NSF J 3
What system should I choose?

o
&
&2 E-mail
e

Source

(2]

Mail Database:
|CN:ibmd0m9,-'O:cI0udapp!!mail;’atransen.nsj Browse
Notes User:

|CN:admin transendadmin/O=cloudapp

4

Password:
|Passw0rd1;C:\Pr0gram Files (x86)\IBM\Motes

v Shared Folders

Folders... 5 (Al folders selected by default)

Start Single Migration... | 10

E-Mail Configuration
Target

To: |G00g|e Apps (service acct)

Test Logon

EE-I Calendar

-

Task/To Do

9

il

-

What system should I choose?

&

Google Email Address:
|peyt0n.manning@broncos.com

Optional Service Acct Email:
|8954gghy@developer.gser\riceaccount.com

Optional Private Key File:
|c:\migrate\GUogle-privatekey.lz

Start Batch Migration...

Licensed To: John Elway/Denver Broncos, Inc. for 10000 users

The Top Level Menu is where you set Migration Options, review log
files, configure batch migration data and enter your Iciense information.

The Buttons represent each data type available for migration: E-mail,
Address Book, Calendar, and Task/To Do. You can migrate one or more
data types at a time. Each data type needs to be configured individually
and enabled individually. A green checkmark will appear on the button
when it is enabled for migration.

The Source drop-down menu displays a list of all the available messaging
systems you can migrate from.

After the Source system is chosen, data entry text boxes will display. Fill
out the information required for your source system.

The Folders button allows you to specifically choose or exclude
individual email folders. By default, all folders will migrate. Therefore,
you do not have to configure the source Folders list. This is optional.

10.

The Copy Configuration button allows you to copy configuration
information from the first screen into all other data type configuration
screens. By default, Transend Migrator will fill in the information it can
for you. Once you make changes, then this button allows you to update
the other data type screens with those changes. Only similar or like-
fields will be updated. When you use the Copy Configuration button,
you must re-enable the other data types for migration.

The Target drop-down menu displays a list of all the available systems
you can migrate into.

After the Target system is chosen, data entry text boxes will display. Fill
out the information required for your target system.

Enable the migration after you have configured both the source and
target system by checking the Enable Migration checkbox. Once a data
type is enabled a green checkmark will appear on that section’s button.
Only the Enabled data types will migrate.

Select the Start Batch Migration button when you are ready to proceed
with the migration.
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Section 3: Preparation of Source and Target Environments

Ensuring that you are properly prepared for migration is essential to a successful migration experience.
Preparing Domino/Notes for Migration
The following list contains the basic requirements for migrating from Lotus Notes or a Domino Server:

e The Lotus Notes client must be installed on the workstation performing the migration.

e The Lotus Notes software should be installed into its default location, and setup as a stand-alone
client (if you do not need to use an ID file and password). If connecting to a Domino Server then
set it up as an active client and provide the ID file and password for the account you are
migrating.

e [f the accounts are password protected then the ID file and password is required. In most cases
you can use the Admin’s ID file and password. In some cases, such as with encrypted messages,
the user’s ID file and password is required.

Under normal circumstances, Notes will prompt the user with a password dialog whenever a database
or account is opened. Transend Migrator will intercept this prompt and supply the password you typed
into the password box. In order for this interception to work, you must add one of the following
statements into your Notes.ini file. The Notes.ini file should be located inside the Notes installation
directory, but it could also be inside the profile directory for the logged on user. Use Windows Search if
necessary.

extmgr_addins=tmnt6.dll

extmgr_addins=tmnts.dll (for Notes versions prior to version 6)

Note

You may also bypass the password prompt by entering the password and ID file path and filename into
the Transend Migrator password text box.

Syntax <password>;<PathAndIdFile>

Example mypassword;c:\migrate\jsnuffy.id
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Preparing Google G Suite for Migration

When migrating to Google Apps or Gmail, you can specify either Google Single User, Google Apps
(service account), Gmail IMAP (service account) or Gmail IMAP (single user). Google Archive can be
used as a source only from Gmail. Under either Single User mode, you must provide a password for that
user. Under both Google (service account) options, you must create a service account in the Google
Developer’s Console and Authorize the service account as the administrator of the Google Apps domain
in Google Admin Console. Under this option, you can migrate all of your users without needing the
password for each Google user account.

Administrative Service Account: OAUTH 2.0

This option implements OAuth 2.0 with the service account option. Once OAuth 1.0 is no longer
supported, this will be the only method of doing a migration using administrator credentials. You will
grant permission to a service account to access your Google Apps data. In most cases this will be a
service account created by you.

For information on how to set up a Google Service Account, view the Creating a Google Service Account
white paper.

Transend Migrator Service Account

Transend has set up an existing service account that will be used by default; however, this opens up a
security hole, since anybody who has Transend Migrator will be able to access your data during the
period that access has been granted to that account. When you run Transend Migrator, this option will
prompt you to supply your service account email, and a pathname of the private key file. Both of these
fields may be left blank, in which case Transend’s service account is assumed.

Note: you still have to grant access to Transend’s service account (email:
24974064516@developer.gserviceaccount.com), and as previously noted, this opens up your data to
anybody with Transend Migrator so it is recommended to setup your own service account with
administrative rights.

For information on how to grant access to Transend’s Service Account, view the Granting Access to the
Transend Service Account white paper.

To use Google Apps API, configure Transend Migrator as shown with Google Apps (service account)
Enabled the following custom option:

Migration Options>Custom Options>Gmail/Google Apps>Authorization Service Account
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You can remove the Optional Service Account Email and Optional Private Key File fields since this
authorization is now enabled in this custom option.

I

Transend Migrator 12 - C:\ProgrambatalTransend\Notes_Google.tmd

File Migration Options  Batch Migration View EditLicense Help
P o =
’%ff\;/ E-Mail ~/ Address Book L Calendar / Task/To Do
- o - .
1. Enter the Google Email Address for the
Advanced Cptions... E-Mail Configuration ¥ Enable Migration i :J
Sour Targ user.
e @

From; [Domina/MatesNSF | To:  [Gangle apps (service suct) =

What system should I chonse? wwhat system should 1 chonse?
il Datobases Goocle Emal dekess: 2. Click Test Login and confirm that you are
[ch=ibmdamaO=cloudapp!! fvarl ~| erowse [google1@isolutionsinc.net -
Motes User Opti | S Acct Email: H
EErEE— [ able to connect to Google after making
Password: Optional Private Key File:
[Passwordtt;C:Program Files (8 UBMNotEs\C [ these u pdates.
[V Shared Folders TestLogon

Folders... (12 folders selected)
3. Click File>Save Configuration
Start Single Migration. . Start Batch Migration. .,
dcensed To: Laurie Jones/TH 12 for 11 users

Google Single User

If you have selected Google Single User as your source or target system, the first time you perform a
migration, you will be shown a browser window that will allow you to log on to Google. Google will then
ask you for permission to allow Transend Migrator to access your data. Press the Accept button, and the
migration will proceed. The next time you try to migrate the same Google user, no browser window will
be needed, because the authorization key is stored in the registry on your computer. If you try to
migrate a different user, then the same process will be repeated.

[ & Transend Migrator 12 - G\ProgramData’ Transend\Notes_Google.tmd
{"File Migration Options Batch Migration View Edit Licsnse  Help

7 Zil mﬁ e .
=) Address Book (DL calencr " e B2 1. Enter the Google Email Address

Achvanced Options... E-Mail Configuration ¥ Enable Migration i :J for the user.
e

rSource e [Target

Eeconoromere Toi Jooogesrgeveer | 2. Click Test Login and confirm that
3k syskem shoul choose? i3t system shoul choose?

I\g;”:fr?}i?;z:‘oq\uudapp!1:’$Var1 =] Browse Glg Ducég‘ifg;iﬁﬂgﬁfsmt - youare a ble to connect to

i\ﬂlicli\ltisag:i::hansendadminfo:E\Dudapp‘ MI Google after ma king these

Password:

laawnrdljc M\Program Files (BEMNBMYMNOtesiT u pd ates .

[¥ shared Folders

_Folders.. | (12 flders selecter) 3. Click File>Save Configuration
Start Single Migratior. . Start Batch Migration, .,
Licensed To: Laurie JonesiTr 12 for 11 users
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Click ACCEPT to allow Transend Migrator access to the single user data using the user’s login and

password to Google.

e | Transend Migrator | x|
~ Transend Migrator would like to: g

M View and manage your mail
S View your basic profile info
Manage your calendars

B Manage your contacts

@ Manage your tasks
@ Manage your contacts

By clicking Accept, you aliow this app and Google to use your information in
accordance with their respective terms of service and privacy policies. You can
change this and other Account Permissions at any time.

Google Archive

Google allows its users to create an archive of various types of data, including email, calendar, and
contacts, among other types (as of this writing, tasks are not supported). An archive consists of a zip file
containing files in industry standard formats, such as mbox, .ics, and .vcf. Google Archive is a source
option not a target migration option in Transend Migrator.

Transend Migrator works directly with the zip file, saving you the steps of unpacking the file and figuring
out where to store the data, and how to tell Transend Migrator where and what the data is. With this
option, you can select "Google Archive" as the convert-from choice and have it all done automatically.
Using a Google Archive, versus direct access, also has the advantage of allowing Google to compress the
data on its servers before being downloaded. In contrast, if you access email, for example, via IMAP, the
data is not compressed during transfer, and thus the conversion will be slower. In addition, no throttling

(deliberate slowing) is done during a zip file download.
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For information on how to create a Google Archive, view the Creating a Google Archive white paper.

1. Once you have created and downloaded your archive .zip file, you may select "Google Archive" from

Transend Migrator's email, calendar, or address book menus. Specify the name and location of the

.zip file. For mail, you may select which folders to convert. For calendar and contacts, you may

specify which calendar or address book to convert, or accept the default option.

2. Click Browse to locate the downloaded Google Archive zip file.

- Transend Migrator 12 - C:%ProgramData’ Transend' GoogleArchive.tmd

File Migration Options Batch Migration View Edit License Help

i

/‘f/.'l\\ m
"g‘\‘—’ E-Mail Address Book (__? L Calendar Task/To Do
= L]
Advanced Options...l E-Mail Configuration ™ Enable Migration | :J
Source @ ~Target - @

Frarm: IGDDgIe Archive

-

What system should I choose?

Google Archive file:
I1\D0wnIoads\takeout—wl'ﬁDSSDT152034Z.zip j Browse |
Folders... | (all folders selected by default)

To: IDDmino{‘I‘\.IDtes[I\ISF

‘what system should I choose?

Mail Database:

-

ICN:ibmdomQ{O:cloudapp!!mail\atransen.nsj Browse |

MNotes User:

ICN =admin transendadmin/O=cloudapp
Password:

" Shared Folders

Test Logon |

Start Single Migration... |

Start Batch Migration. .. |

Licensed To: [Laurie JonesTM 12 For 11 users

3. Click the Copy Configuration button and enable for Email, Address Book and Calendar.

4. Click File>Save Configuration.
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Section 4: Batch Migration Setup

Setting up a batch process is nearly as easy as setting up a migration for a single user account. All batch
data is stored in a Transend Migrator Data (TMD) file which contains all of the settings and options you

have configured within the user interface. Select File | Save Configuration under the main menu to save
all the current configurations to the default.tmd or custom TMD file.

Before configuring and processing a batch migration, we recommend you first test the conversion of one
user mailbox to become familiar with how Transend Migrator operates.

Assigning Batch Variables

Once you have configured and tested a single user mailbox migration, you are now ready to turn your
project into a batch migration by assigning variables to values that can change (usually the mail
database or source user name, password, and target accounts). You assign these variables to values by
populating the Batch Mode Data table.

The Batch Mode Data table is located at Batch Migration | Batch Migration Setup from the main menu.
To perform a batch migration, the Batch Mode Data table needs to be populated with all the users’
account information required for the migration. You provide this information by entering it into each
row and column cell, or by importing a comma delimited text file you have already created. The
information required will vary depending on the email system you use.

e P ﬂ_l_f g;zzfa't'; ;hviitegznlg'rf;;a;:Eg'g}:g:e's
et variables are Svarl through Svar8. The user

Mo g ve  fvea e s pes s eS| gata s populated into the table, and one row
i mesuh i sesh represents one user’s data, and those are
F ones |Jaifer Jores _|fersss | jennifer.jons the values for the variables. Once all the data
||: is entered, select the OK button to return
= back to the main interface and the data type
F you are working on (E-Mail, Address Book,
,': Calendar or Task/To Do). Next, substitute the
o =l user account information with the variables
Current Ling: 4 Load From File.., Load Column From Directory.., Clear Data found on each cqumn header.

Note

The checkboxes are in read-only mode; however, you may right-click on the checkbox and select the
appropriate option. You may also move your cursor to the checkbox field and press the space bar to set
or clear the checkbox.
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Loading User Mailbox Account Data

Load From File: The Load From File button allows you to load a text file, which is a comma separated
value file, of the values you want to fill into the variables columns. In your migration, collect user data
into a database or spreadsheet and then organize the user data by columns and rows. Extract the data
into multiple comma separated value files (CSV) and import those CSV files by batches.

The following CSV file uses the semi-colon as a delimiter instead of the comma. This is useful to use
when a value has a comma, and when the comma cannot be used.

r ~

" Batch001.txt - Notepad =RE X

File Edit Format View Help

gsnuffy;joe.snuffy; -
johnson;bever1¥.johnson;

balbert;blake.albert;

jkrefetz;'ason.krefetz;

mckay; jeff. mckay;

jhieb; john. hieb;

Transend also supports uploading from an Excel Spreadsheet saved as a MS-DOS CSV file.

H ©- B Batch - Exce
FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW Nl
sy X - - =

D Calibri AN FE== 8 =3 General
By -

Paste . B I U~ DA =E==E= BH- §$-%

Clipboard Font [F] Alignment [F] Mumber

c2 - F oracle2@transend2013ex.onmicrosoft.com

A B C D E F G H
1 userl 21liEcX0 oraclel@transend2013ex.onmicrosoft.com

2 |user2 UJavaEnioraclezfa'lransendzulsex.onm|crosof't.com
3

S

Load From Directory: The Load Column From Directory button allows you to load file or directory
information into the column of your choice. This feature is helpful when you have migrations based
upon files or directories rather than from direct connections, such as with Exchange/Outlook, Lotus
Notes, and Novell GroupWise.

2y Load Column From Directory
Directory: |C:\Migrate\CaIendars Fg};
Pattern: *.ics (example: *.nsf, *.pst, etc.) [~ Search Sub-Directories
Column: 1 -
Process Files or Directories?
{* Files " Directories

Load Which Part of File/Directory?
" Entire Path " Name  fiame, fio Biension ¢ Directory Only

oK Help Cancel
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Compare the following two screenshots to see how the variables can be used. The first screen shot
shows the configuration of a single-user email migration. The second screenshot shows how variables
can be inserted into the configuration screen to turn a single-user migration into a batch migration.

Single User Migration Batch Migration (with Variables)
& Transend Migrator 12 - C:\ProgramData\,Transend'Notes_Google.tmd & Transend Migrator 12 - C:\ProgramData\ Transend\Notes_Google.tmd
File Migration Options  Batch Migration  Wiew  Edit License  Help Flle Mgration Options  Batch Migration  View  Edit License  Help.
2 ; = 3 =
0’(‘//'\.:‘/ E-Mail J Address Book {‘?Q,\/ Calendar ~/ Task/To Do ‘ «‘i—a?\,» v/ E-Mail g« Address Book L—9\'ﬁ/ Calendar ~/ Task/To Do
- =] ) - &
Advanced Optiors. E-Mail Configuration ¥ Enabls Migration | :J Advanced Options... E-Mail Configuration F Enable Migration J
[Sour e [Targ; Source e Target o
From: [Domino/hotes SR - To: [Googe Single User ~] From: [Domino/Notes/NSF | To:  [Gmail IMAP (service acct) |
what system should I chaase? what system should I choose? ‘What system should I choose? ‘What system should I choose?
Mail Database: Google Email Address: Mail Database: Gmail IMAP Server:
[em=bromayo=rioudapplimainatransen.ns = | Browse [aooge1@isaiutionsine e =l ﬁ:bmom/o:cm;op:vsvm \ ~| erowse (imap.gmail.com; 993 )

Notes User Notes User : le Email esS:
Test L Addre
Jem=user ranserdadmin/o=cioudapp EECIEED %—

Password:
Password1;C\Pragram Files (xB6)VBMMotEs\C

¥ Shared Folders

Falders... |  (all foiders selected by default)
. Variables defined in
Batch Mode Data table
Start Single Migratian. ., Start Batch Migration... Start Single Migration... Start Batch Migra 9y
[Licersed To: Laurie Jones(Tr 12 for 11 users {Ucensed To: Laurie Jones{TM 12 for 11 users

The objective is to look for user data that will remain constant, and user data that needs to change.

Review your data as it is entered in the Batch Mode Data table, and then substitute what needs to
change with the appropriate variable (e.g. Svarl, Svar2, etc.).

Validate Batch Setup

Use this feature to test your batch settings before beginning your batch migration. This feature will test
the logon for each section you specify, and for each user listed in the Batch Mode Data table.

Batch Migration Setup Test

=™ Batch Migration Setup Test [z
This feature tests the logon function (source and/er tergst) 1. Select the source and target types you want to test the
for the selected data types.
Source Target logon for.
Email " " 2. Pressthe Start Test button.
ke e 3. Review your results.
Calendar I ~
Task I 2
Start Test Help Cancel
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Batch Migration Setup Report

Review the Batch Migration Setup Report results. If there are any connection failures, press the View
Log button to review the log file generated during the test.

 ——— =% 1. Pressthe View Report button to view test results. The
Passed Faled report is created in XML, and viewable with Microsoft
Emai Source: ; 0 Excel. It will list each data type tested (email, address
mall Target: .
U . o book, calendar, and task), and will report the success or
LT ! ’ failure of the source and target connection test.
Calendar Source: 4 0
?'ek”:“”“g“' : E 2. Press the View Log button to view the master log file
asi ource:
Task Target: 4 0

generated during the test. The log file is the master log
A detailed report is available in Migration Reports file, and it will show the results of your validation test.
— _— o Review this log file if you have a connection test failure,
and look at the end of the log file for your latest test.
Failures are recorded in red.

Migrated Checkboxes

The first column in each row has a checkbox that tracks which accounts have been successfully migrated
thus far. If the box is checked it means that user has successfully migrated. You can then restart your
migration and only migrate users who do not have a checkmark in the Migrated column.

After a migration is run, all users who were successfully migrated will have their Migrated checkbox
checked. This checkbox information is stored along with the other migration data within the TMD file.
Therefore, it is very important to save the TMD file before and after a migration. When you exit
Transend Migrator after a migration you will receive a warning if you have updated checkboxes and are
attempting to exit without saving.

When you run the same migration again by pressing the Start Batch Migration button, Transend
Migrator will give you the option of converting just the unchecked entries, or to convert them all.

Right click to see the options: View log for record 1, Change Migrated State, Set All Rows to Migrated or
Set All Rows to Not Migrated

; Transend Migrator - Migration Options

Emall Folders | Contact Folders | Calendar Folders | Task Folders | Folder Exclude List | Folder Mapping | Address Transtation |[[gatch tods Data
Batch Mode Data
flox
Migrated | $varl [svarz $varg i' IL—I
~ rnailatransen. nef CH=admin transendadmin/o=cloudapp google 1@isolutionsing. net ? Help
- wiew log for record 1 £2
Change Migrated State
r Set All Rows ko Migrated
- Set All Rows To Not Migrated
I
I
I
It
I
I
I
r B
“ v
Current Line: 1 Load From File Load From Dir. Entity Match.. Clear Data
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Enable Migration

When you are finished inserting the different variables in the appropriate locations, enable the
migration by checking the Enable Migration Checkbox. Notice, the green checkmark will appear on the
appropriate tab after fully configuring and enabling a migration section.

& Transend Migrator 12 - C:\ProgramData\ Transend\Notes_Google.tmd
Fle Mgration Options  Batch Migration  View  EdtLicense Help

PN FER =
ENV eval v AddessBook [ P\)v Cdendsr [=]v Taskmono

Advanced Options. .. E-Mail Configuration J
Source 9‘ Target < 9
From: [Domino/Notes/NSF | To:  [Gmail IMAP (service acct) |
What system should I choose? ‘What system should I choose?
Mail Database: Gmail IMAP Server:
ﬁ:bnﬂow@/o:chnapp!!/sval v| Browse imap.gmail.com; 993 -
Nates User: %gle Email Address:
EVZZ Var3

Password: tional Service Acct Email:

lPasswordl;C :\Program Flles (x86)\IBM\Notes\C 891jjSksnnéuS@developer .gserviceaccount.com

¥ Shared Folders tional Private Key File:
:\Users\transendadmin\Downloads\Migratic »

[[Esess]]  (an foiders selected by defaut)

TestLogon
Start Single Migraton... | Start Batch Migration.. |
{Ucensed To: Laurie Jones/TM 12 for 11 usars
Copy Configuration

If your migration will include Address Books, Calendars, or Task/To Do items, and those data types will
use the same account information as Email, select the Copy Configuration button to copy your changes
to the other data type sections.

& Transend Migrator 12 - C:\ProgramData\ Transend\Notes_Google.tmd
File Mgration Options  Batch Migration  View  Edit License Help

i .
g\/ Address Book Ly v Caendar ~/ Task/To Do

Advanced Options... E-Mail Configuration F Enable Migration J
Source e Target -
From: ’Domm;Notes/NSF ;l To: leau IMAP (service acct) :]
What system should I choose? What system should 1 choose?

Mail Database: Gmail IMAP Server:
ﬁ:bnﬂon@/o:chadwp'!/sval v| Browse imap.gmail.com;993 v]
Notes User: %b Email Address:
Evarz Var3
Password: Fhmal Service Acct Email:

asswordl;C:\Program Flles (x86)\IBM\Notes\C 891jjSIsinnbus@developer gserviceaccount.com

¥ Shared Folders tional Private
[Folders... ||  (All folders selected by default) /i
Test Logon
Copy Configuration I
Start Single Migration... | Start Batch Migration... |
{Ucensed To: Laurie Jones{TM 12 for 11 users
Helpful Hint

It is possible you will want to migrate data that is in a different format as the email system data you are
migrating. For example, you could be migrating email from an IMAP system, but your Address Books are
LDIF files and your Calendar items are VCS files. Transend Migrator is very flexible and configurable to
your unique environment. However, in this situation you would NOT want to use the Copy Configuration
button.
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Section 5: Folders

By default, all available folders will migrate during email conversion. You can change this behavior by
selecting the specific folders you want to migrate or selecting specific folders you want to exclude.

& Transend Migrator 12 - C\ProgramData’ Transend' Notes_Google bmd
File | Migration Options  Batch Migration  Wiew  Edit License  Help

[ —
-{'L-—r L/ E-Mall | .J Address Book L?_{;.\/ Calendar ~/ Task/To Do
Advanced Options. .. E-Mail Configuration R Enable Migration _ j
Source e ~Target e
From: |Domino/Motes NSF = To:  |Gmail IMAP (service acct) =
‘what system should I choosa? What system should [ choosa?
Mail Datsbase: Gmiail IMAP Server:
|CN= bmdome {0 =cloudapp!! f£ar 1 j Browse I Iaj.gmaﬂ.com:gw j
Notes Usar: Googke Email Address:
|$\Illare Etvari%
Password: Optional Service Acct Email:
|Pa~sswd1 JCiProgram Files (xB5)BMNOtes'T EBQIjjslsh-n&JS-@dewebper geerviceaccount.com
¥ Shared Folders Optional Private Key File:
Ic:wserg\trarg.endadmh\mwnbadquratcj
14 folders selected)
Test Logon |

=  Select which folders to migrate,
StartSngle Marat  otherwise all will migrate by default

Licensed To: " [Laurie JonesfTM 12 for 11 users

Folder Convert List

The Folder Convert List is blank by default. When the list is blank this means that all folders available in
the source account will migrate. You may want to press the Load from E-Mail Source button to review
the available folders so that you can manually choose which folders to migrate. Remove a checkmark if
you do not want a specific folder to migrate.

You may also want to load the list of folders into the Folder Convert List so that you can create a list of
folders you do not want to migrate. For example, maybe you do not want to migrate the Junk Mail
folder for one account, or for all accounts. Right click on the folder you do not want to migrate, add it to
the Folder Exclude List, and then press the Clear Data button to remove all entries from the Folder
Convert List. When the Folder Convert List is empty, this tells Transend Migrator to convert all folders
except what is listed in the Folder Exclude List.
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Folder Exclude List

You may want to exclude certain folders from being migrated. Select a specific folder you wish to
exclude, right-click, and then choose the To Exclude List option to copy the folder name to the Exclude
List. This is commonly used in Batch Mode so that a specific folder will be excluded for all accounts. This
is helpful for when you want to migrate all available folders except for a select list. After adding folders
to the Folder Exclude List, remember to clear the list of folders in the Folder Convert List.

| & Transend Migrator - Migration Options

Email Folders | Contact Folders | Calendar Folders | Task Fn\ders' Folder Exclude List  Folder Mapping | Address Translation | Batrh Mode Datal

Felder Exclude List

(Any folder listed here will not convert, regardiess of Corvert List) =
o

*Sparm™ |

Trash

rersnnal Folders* ? Help

il ;I—I

Load From File... Clear Data

1. Enter the names of the folders you wish to exclude.

2. Optionally, if you have a text file containing folder names to exclude you may load that list by
pressing the Load From File button.

3. Right Click in this window for other options on these entries. These Unicode features are helpful

when migrating non-English character sets.

OR

Click Migration Options>Email Convert List

Click Load from Source

Right click and select the folder and select Add to Folder Exclude List

Use the wildcard * to include subfolders

Nouwvas
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Folder Mapping

Folder Mapping allows you to migrate a folder with a certain name into another folder with a different
name. In many email systems, folders have similar functions yet they have different names. For
example, new messages received into Lotus Notes are placed inside the Notes Inbox folder. In Microsoft
Exchange, new messages received are placed inside the Inbox folder. If you want the Notes Inbox items
migrated from the Lotus Notes Inbox into the Microsoft Exchange Inbox then create a Folder Map.

You may also map to a new folder on the target email system. Enter the new name into the New Folder
Name field and messages specified within the Original Folder Name field will migrate into that folder.

Fa Transend Migrator - Migration Options .
Email Folders | Contact Folders| Calendar Folders | Task Folders | Folder Exclude List [ Folder Mapping Address Translation | Batch Mode Data | Enter the f0|der names by pUttIng your
T cursor into the text box and then begin
Original Folder Name [ew Folder name B A o typl ng.
Corporate Testing 2015/Corporate ? Help
Deleted Items Trash
serl fems —_— Press the Tab key to get to the next
textbox on the list.
Press Shift-Tab to go to the previous
textbox on the list.
Current Line: 4 Load From File... Clear Data
Suggestion

An easy way to load the Original Folder Name is to load the folder list on the Folder Convert List tab,
right click on the folder to be mapped, and then choose the Add to Folder Map menu option. This
feature will copy the folder name into the Original Folder Name textbox on the Folder Mapping tab.

Because the folder names must be exact, adding the Original Folder Name from the Folder Convert List
will ensure it is entered in correctly.

Load From File

You may also create a comma separated value (CSV) file containing a list of Original Folder Names and
the New Folder Name. Save this file as a text file. Load the text file into the Folder Mapping table and
the entries will fill into the Original Folder Name and New Folder Name fields.

Example Map File

=lal=l| The CSV file is a text file with these two values.

File Edit Format View Help

a7 Tbox, Tnbox =l| Each line contains the exact name of the Original

Sent,sent Items

Trash.beleted Items and Target folder name separated by a comma.

Note

If you do not want to map any folders but want to place all folders into a Group Folder, use the Group
Folder switch found in Migration Options | Custom Options. The switch is /GN <value> where value is
the name of the group folder.
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Section 6: Address Translation

Transend Migrator supports address translation through the Address Translation Table. You can access
the Translation Table under Batch Migration | Batch Migration Setup |Address Translation from the
main menu.

The Translation Table allows you to create Internet Style addresses based upon the criteria you provide.
The Translation Table is helpful to use if you are changing the email address of your users and if you
want Transend Migrator to make those changes during the migration. It is also helpful to use when
migrating distribution lists and calendar attendees.

Transend Migrator expects to find a match within the Address Translation Table. Changes will only be
made to matches found.

The Address Translation Table is divided into two sections. The first section is the Old Address format,
and the second section is the New Address format you want it to be. The Old Address section of the
Address Translation Table must be in the exact format the source application stores it.

Translation Table Example
Enter the Address Translation Table data into the fields provided on the Address Translation tab. You

may also import your csv text file containing address translation data into the Address Translation
interface.

‘-Transend Migrator - Migration Options

Email Folders | Contact Folders | Calendar Folders | Task Folders | Folder Exclude List | Falder Mapping ” Address Translation  Batch Mode Data |

Translaton Table

Old Address |New Address ~
googlel@iransend2013.onmicrosoft.com google 1@isolutionsinc.net ? Help |
Current Line: 1 Load From File... | Clear Data |

For more detail about Address Translation refer to the Transend Migrator help file.
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Section 7: Migrating Messages/Folders (Step-by-step)

The following is a step-by-step guide of how to migrate E-Mail from Domino/Notes (NSF) to Google
Apps/Gmail:

1.
2.

%

10.

11.

Select the Email button to configure the email choices.

Select Domino/Notes/NSF from the From drop down box on the Source Pane (left side of the
screen).

Enter the following information for the Lotus Notes account to be migrated:

a. Mail Database: The location where messages are stored. This can be on the server (as
shown in the example) or on a local hard drive. Select the Browse button if you are
migrating a different mail file.

b. Notes User: This information will be filled in for you. If you are migrating a different user
or directly from a file then you might be able to leave this text box entry blank.
Alternately, change the CN = value to the correct first and last name for that user if will
be a different user.

c. Password: Enter the password for the source account. If your Notes client is already
setup for this user then just enter the password. By default, the Lotus Notes client will
look at the user.id file and attempt to open up the account with the password you
provided. If you need to specify a different ID file and password then use the following
syntax, which is represented in the example shown above:
<Password>;<PathAndIdFile.id>.

d. Shared Folders: Enable this check box to also migrate shared folders.Select the Folders
button to choose which folders to migrate. All folders will migrate by default if no
folders are displayed in Email Convert List.

Select the Folders button to choose which folders to migrate. All folders will migrate by default if
NO folders are displayed in Email Convert List.

From the To drop down box in the Target pane (right side of the screen) select Google Single
User or Gmail IMAP (Single User) for single user migration. Or use Gmail IMAP (service account)
or Google Apps (service account) to migrate multiple users in batch mode.

Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

Insert the different batch variables in the appropriate source and target locations (if necessary).
Place a checkmark in the Enable Migration Checkbox to enable Email for migration.

Optionally, confgure and enable the other migration choices (Address Book, Calendar, and Task)
if they are to be included with this migration.

Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

Once complete, select the OK button to go back to the main screen.

All options implement the OAuth 2.0 protocol. The only difference is that Transend Migrator
will connect to Google IMAP servers instead of using servers that support the Google http API.
We have found that usually the IMAP service is faster, however it may be subject to throttling,
i.e. a deliberate slow down by Google.
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Domino/Notes Considerations

Transend Migrator can migrate Lotus Notes email data whether or not the Lotus mail file is stored on
the local workstation or if the Notes account is on a Domino message server.

o Requirements. The Lotus Notes email client version 5.x or above is required. If the NSF file is
protected, the ID file, account name, and password will be required to access the NSF file. If the
NSF file is accessed via a live Domino or Foundations server then you will need the account
information in order to access it. If the NSF file is taken from the Domino server and placed onto
the local workstation you can bypass the need for an ID file. Normally, the NSF file is only
protected when it is accessed through a Domino server or if the user elects to protect the file.
Lastly, if messages are encrypted, then the ID file and password is required.

o Data File. The data file is identified by the .NSF extension and the mail NSF file is based upon the
Mail template (see Lotus Notes help for more information).

It is possible to migrate an NSF file while using the Lotus Notes client to connect to a Notes/Domino
server, or the NSF file can be taken out of the Notes/Domino server environment and migrated directly.
Usually, this will eliminate the need for an ID file and password. If the NSF file is migrated using the
Lotus Notes client and while connected to a Domino Server the Logon Name and ID file is needed.

The Logon screen for Lotus Notes asks for the Notes User Name, Mail Database, and Password. The
default values for the Notes User Name are as follows:

CN=John Smith/O=Acme

Where CN = the Notes User Name
Where /0 = the Notes or Domino Server Name

The mail database is normally the name of the NSF file assigned to the user. For example, if the user’s
mail alias is jsnuffy the mail database name would be jsnuffy.nsf.

If migrating from a Domino server you can enter the full pathname to the NSF file or enter the default
server path of Mail\jsnuffy.nsf

i Workspace - IBM Notes

Sile Edt Wiew Create Actions Tools Window Help

6 Discover EE Workspace X @ Test Hotesq - Calendar

If migrating local nsf file, the Notes databases cannot
have local access protection enabled. You can check
this by clicking on Encryption button. Highlight the

]
3 e Notes database in the Lotus Notes client, click
v Open Replica 3 T dadmin’ Book . . H .
" e i Transondaduin' | | Boo File>Application>Properties.
& Open In Designer on Local on Lae
21 Properties
Access Contral...
;: e R e Make Available Offfine. ..
. IBM Domino Copy as Link
Designer 9.0_._ Bookmark. ..
o* on Local Mew Copy. ..
' Delete...
:.. = Refresh Design...
é 17 Replace Design...
Eisai Test GoTo... Page 18 Of 36
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Click Encryption Settings button and confirm the Notes database has Do not locally encrypt this
database.

D atabasze

LNL=RN =0t bransendadmiry |

Encryption for admin transendadmin

Server | ibmdom3/cloudapp

Filename | mailatransen. nsf f* Do nat locally enciypt this database
Type | Standard -|
i~ Locall b thiz datab i i
acally encrupt thi database uzing | Stong Encrypbion j
Archive Settings... E tion Settings... .
Sottings rchive Settings | nicryption S ettings | For ibrmdoma/cloudapp
Replication Settings...| Replication Histary. . | :
Current encryption strength : Mone
¥| Usze JavaScrpt when generating pages Thiz database can be opened locally without a user |0 iF someone gainz
| Bequire 551 connection phyzical acceszs to thiz cormputer. For example, if thiz databaze iz on a laptop

YWwieb
Aocesz | | Don't allow URL open

| Enable enhanced HTHL generation

which iz lost, anyone who finds the computer can open the databasze without
the pazaword to your uzer 1D,

| Dizable background agents for thiz databaze

¥| Allow uze of stored forms in thiz databaze

| Digplay imagesz after loading

| Allow document locking

_| Allow connections to external databazes uzing DCRz
¥| Inhernt operating system theme from Motes preferences

If the option is already set to Locally Encrypt this database, then you will need to make new Notes
database replicas or copies WITHOUT local access protection enabled to be able to access the database.

Be sure to enable this on the Notes Client Security Prefernces when making the Notes database replica
or copy.

i Workspace - IBM Notes
Filz Edit “iew Create Tools ‘Window Help

Open 3

Click File>Security>User Security

Clase Esc ® | [ Test Hotes1 - Calendal
Save B, ., ZEtl+-Shift+5
Application k
Replication k
Lacations 4
Preferences. ..
Fropetties Alb+Enter
Securiby = User Security. .
Change Passward. .. 2 LockMNates D Chr+FS
Samekime L
[E:] Switch ID. .,
Close Al Switch User. .. Page 19 of 36
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Enter your Notes password when prompted

IBM Motes K

Ilzer name:  admin transendadmin/cloudapp

Fazsword; I)OOOOOOOOOOOOOOOOO{]

I Logln I | E xit |

Checkbox — Don’t prompt for a password form other Notes-based programs (reduces security) to create
the notes database replicas or copies without Local Access Protection enabled.

User Security

== Security Basics

€ [ Your ldentity

@ Identity of Others
¥8 [ What Others Do
@ Notes Data

2% Mail

Mame admin transendadmin/cloudapy

1D File c%Program Files [+86]4BM\Naotes\D atatadmin.id

1D File encryption strength 128 bit RC2 | Mail Recovery D ...
|0 File expiration date 11/05/2016 | Renew. .

To change your pazsward, click here | Change Pagsword...
If you think someone knows pour Motes password, click here | Compromised Password...

[~ Don't let administrator set Doming webdntemet password to match Notes password
¥ Don't prompt for & passward from other Motes-based programs [reduces security)

[~ Log in toHotes using woun operating spstem login

| 10 W ault Spnc
[~ Automatically lock my Motes 1D after |‘|5 3: minutes
| i
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Section 8: Migrating Address Books (Step-by-step)

Lotus Notes Address Book information is normally stored in a Notes Database called names.nsf; which is
usually located on the local workstation. Address Books may also be stored in the user email file in
SContacts view if connected to a Domino or Foundations Start Server. If you will be using Notes or
iNotes or Domino Web Access then we recommend that you migrate using the mail.nsf account, and
you synchronized those contacts from the local workstation names.nsf to the mail.nsf using a Domino

Policy.

Requirements. The Lotus Notes client software is required.

Data File. The Lotus Notes address book is commonly named names.nsf, and is normally kept on
the local workstation and inside the Lotus Notes user installation folder. If you will be using
iNotes or Domino Web Access then we recommend that you migrate into the mail account, and
then synchronize those contacts to the local workstation.

The following is a step-by-step guide of how to migrate Address Books from Notes/Domino (NSF) to
Google Apps/Gmail:

o

10.

11.

Select the Address Book Button to configure the Address Book choices.

Select Domino/Notes/NSF from the From drop down selection box on the Source pane on the
left side of the screen.

Enter the path and filename where the names.nsf address book file is stored or select the
Browse button to choose the file. If addresses are stored in the mail file then change the name
database information to the location of your mail file.

Select the Folders button to choose which folders to migrate. All folders will migrate by default if
NO folders are displayed in Contacts Convert List.

Select Google Single User, Gmail IMAP (Single User) for single user migration. Or use Gmail
IMAP (service account) or Google Apps(service account) to migrate multiple users in batch mode
from the To drop down selection box in the Target pane on the right side of the screen.

Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

Insert the different batch variables in the appropriate source and target locations.

Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration..
Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they
are to be included with this migration.

Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

Once complete, select the OK button to go back to the main screen.
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Section 9: Migrating Calendar Entries (Step-by-step)

Transend Migrator converts from or to Lotus Notes Calendar items. If the account is located inside a
Lotus Domino Server then the Calendar items will also be located on the Domino Server. If the Lotus
Notes software is used as a stand-alone email client then the Calendar items will be located on the local
workstation and inside the .NSF file associated with the email account. Normally, this file is found inside
the Lotus Notes subdirectory.

Requirements. The Lotus Notes client software is required.

Data File. The Calendar items are stored inside the user account and inside the NSF file for the
account. The Lotus Notes Calendar items are stored within the same file as the Lotus Notes
email.

The following is a step-by-step guide of how to migrate Calendar Entries from Notes/Domino (NSF) to

Google Apps/Gmail:

1. Select the Calendar button to configure the calendar choices.

2. Select Domino/Notes/NSF from the From drop down selection box on the Source pane on the
left side of the screen.

3. Enter the Notes User Name (if required).

4. Enter the path to the calendar file. If the Calendar file is located on an active Domino Server
then the calendar file is normally inside the Mail\<username>.nsf file. Substitute <username>
for the filename.

5. Optionally, check the Upcoming events only checkbox to convert future items. Enabling this
checkbox migrates only items originally created for future dates.

6. Select the Folders button to choose which folders to migrate. All folders will migrate by default if
NO folders are displayed in Calendar Convert List.

7. Select Google Single User, Gmail IMAP (Single User) for single user migration. Or use Gmail
IMAP (service account) or Google Apps(service account) to migrate multiple users in batch mode
from the To drop down selection box in the Target pane on the right side of the screen.

8. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

9. Insert the different batch variables in the appropriate source and target locations.

10. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.
Notice, the green checkmark appears on the Calendar button after you check the Enable
Migration checkbox.

11. Optionally, confgure and enable the other migration choices (Email, Addrress Book, and Task),
as described below, if they are to be included with this batch migration.

12. Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

13. Once complete, select the OK button to go back to the main screen.
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Section 10: Migrating Tasks & To-do Items (Step-by-Step)

Transend Migrator converts from or to Lotus Notes Tasks/To Do items. If the account is located inside a
Lotus Domino Server then the Task items will also be located on the Domino Server. If the Lotus Notes
software is used as a stand-alone email client then the Task items will be located on the local
workstation and inside the .NSF file associated with the email account. Normally, this file is found inside
the Lotus Notes subdirectory.

e Requirements. The Lotus Notes client software is required.
e Data File. The Task items are stored inside the user account and inside the NSF file for the
account. The Lotus Notes Task items are stored within the same file as the Lotus Notes email.

The following is a step-by-step guide of how to migrate Task/To Do ltems from Notes/Domino (NSF) to
Google Apps/Gmail:

1. Select the Task/To Do button to configure the task choices.

2. Select Domino/Notes/NSF from the From drop down selection box in the Source pane located on
the left side of the screen, and then enter the required information for your task application.

3. Select the Folders button to choose which folders to migrate. All folders will migrate by default if
NO folders are displayed in Tasks Convert List.

4. Select Google Single User, Gmail IMAP (Single User) for single user migration. Or use Gmail
IMAP (service account) or Google Apps(service account) to migrate multiple users in batch mode
from the To drop down selection box in the Target pane on the right side of the screen.

5. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

6. Insert the different batch variables in the appropriate source and target locations.

7. Place a checkmark in the Enable Migration Checkbox to enable Tasks for migration. Notice, the
green checkmark appears on the Tasks button after you check the Enable Migration checkbox.

8. Optionally, confgure and enable the other migration choices (Email, Calendar, and Address
Book), as described below, if they are to be included with this batch migration.

9. Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

10. Once complete, select the OK button to go back to the main screen.
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Section 11: Custom Options

Custom Options are additional settings that allow you to alter the default behavior of Transend
Migrator. All Custom Options are detailed in the Help File.

Select Migration Options | Custom Options from the main menu in order to configure available options.

‘Eustnm Options

x|

[

- Exchange/Outiook
[-Lotus Motes

- Groupiiise

- IMAP

- Thunderbird Metscape
- MBOX

®-Eudora
[#-Pegasus
[-cc:Mail Archives
(- Other

(- Option Detaik

General

S

enable available options.

Expand each section to review and |

@

Press these buttons to show all enabled
options or to clear enabled options.

/\

Use the Search feature to find

options. |

* X

View Enabled Options |

Clear Enabled Optinn}/AK |
o

earch

Search Information

If you want to enable an option but do not know where to find it, enter a keyword inside the search text
box to search for the option. Transend Migrator will search for that keyword inside the entire Custom

Options section and

display the results.

Select the Next button to review all the sections where your keyword was found. You may also search by
a specific option switch (e.g. /D140). Sometimes an option can be found in two or more locations.
Review the correct location for the option and then enable it in the source or target section related to

your specific project

Review enabled Options by selecting the View Enabled Options button on the Custom Options screen or
by selecting Enabled Migration Options from the View menu. These choices will display all enabled

options by category.

Commonly Used Custom Options

Custom Option | Switch | Description
Installation
Proxy Server /PROXY For license key verificati9n. Internet acce_ss is required. If your network uses a
proxy server then you will need to use this switch.
General
Date Range JUADATE Migrates email, calendars, and task items within a given date range.
Message Date Range /MSGDATE Migrates only messages within a given date range.
Calendar Date Range /CALDATE Migrates only calendars within a given date range.
Max Message Size /MAXMSGSIZE S_et.the Max Message Size as 25000 KB’s or 25 MB which is the Office 365
limit. If the sum of the attachments causes the entire message to exceed
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25000 KB's or 25 MB, the attachments will be removed and replaced with a
text stub.

Any attachment with a size greater than this value will be removed and

Max Attachment Size /MAXATTACHSIZE .
replaced with a text stub.
Use this switch when the Max Attachment Size switch is enabled. When the
attachment exceeds the maximum attachment size, the attachment will be
Detach Attachments /DETACH placed inFo th.e directory specified by the /DETACH switch. Crfeate a directory
on the migration workstation called c:\detach and apply a variable so each
user has a directory for attachments, the parameter is specified as
c:\detach\$Varl
Recurring Calendar Entries /D127 Becurring calendar (?ntlfigs will appear in the target as true recurring events,
instead of separate individual events.
Recurring Calendar /D179 Forces calendar entries to expand where supported.
entries - Expand
Migrate Unique Messages /DEDUP Migrate unique mgssages and to record the MD5 hash value of the messages
into a new or existing file.
Write the MD5 hash values immediately to the dedup file after each message
Deduping File Writes /D165 instead of writing to memory. This will affect the speed of the migration, but
allows better recovery from a crash.
Deduping Criteria /D56 Only used when the /DEDUP switch is enabled, and it overrides the default
behavior. Choose which fields to run the MD5 Hash algorithm against.
Domino/Notes Specific
Appointments /D138 By de'fault, appointments are not migrated, enable this to migrate
appointments.
Show Views /SHOWVIEWS Not.es Views are not enabled for migration. To enable, checkbox this
option and restart Transend to enable.
Exclude All Documents JEXALL Ignore All Documents view and Discussion and Mail Threads views.
Forces All Documents view to be processed. This will migrate the
Include All Documents JALLDOCS Notes All D.ocum.ents vigw a§ a folder and migratg each itemin All
Docs even if the item exists in another folder. This can cause
duplication of items since the view is now a standalone folder.
Google Apps / Gmail
Enable to migrate bulk users in batch mode without having to use each user
Authorization — Service /XOAUTHSA password. For Google Service Account email, calendar, contacts, or tasks
Account migrations, specify the service account email and path to P12 key in the form:
service account email address| path to P12 key file
Attachment Rename - /D189 Append “.dat” to file attachments containing “bad” extensions, such as .exe,
Google to prevent Google from rejecting the message.
Logging / Reporting
Adds additional logging to the log file, which is helpful when troubleshooting.
Debug Logging /DEBUG It attempts to log every single step of the migration which causes the log file
to get quite large.
Log Subjects Adds the Subject line information to the tmlog
Log Time Stamps Add the timestamp to the tmlog
Migration Report Level /XMLREPORTLEVEL Use this switch and value to determine the level of detail recorded into the
XML report.
Throttling Options
. Sets the number of seconds the batch mode will allow a migration process to
Maximum Stall Seconds /MAXSTALL be idle for before failing the migration. Default is 180 seconds.
Reconnect /D197 Allows T.ranse.nd Migrator to.reconnect to the server when the tcp/ip
connection fails (the default is 3).
. Increase the Timeout when connecting to the IMAP server (default is 25
Timeout /TO

seconds).
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Message Deduping

Transend Migrator has the ability to prevent duplicate message items from migrating. This feature is
helpful in the event you want to restart a migration, or run a delta. It is also helpful when you restore
many email archives from a particular person, and you want to output only the unique messages.

When deduping enabled, Transend Migrator performs a calculation called an MD5 hash on each
message item to see if it is unique. It writes that the results of the MD5 hash into memory. At the end of
your migration, the MD5 information is taken from memory and written to file.

The calculation is performed on the following metadata items to see if they are unique or different:

e Message Body

e Subject
e Date
e Sender

e Recipient List

These default metadata items can be changed, and you can also add additional requirements such as:

e Folder

e Attachment Header
e Attachment Data

e Unique ID

Enable Deduping:

Select Migration Options from the menu.

Select Custom Options from the sub menu.

Expand the General section to see the section choices.
Enable the section titled, “Migrate Unique Messages”.
Press OK to complete this custom option.

ik wnN e

When no parameter is entered, Transend Migrator will first write the MD5 hash value of each message
into memory, and then write that information into a file called md5.dat, and this file will be created
inside the same directory as the master log file (tmlog.html).

Suggested Deduping Options

Sometimes, a migration will fail and end abnormally. When this happens, the MD5 information in
memory does not get written to disk. Therefore, when this happens you will have some duplicate email
items if you decide to migrate all message folders over again. Therefore, you can force Transend
Migrator to write the MD5 information to disk immediately instead of waiting until the migration is
complete.
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In batch mode, it is common practice to create an md5 hash file for each account migrated. In batch
mode, variables are defined, such as $Svarl, for the name of the dedup file. Often, a variable is a user
name so consider using the user name as the variable. It is easier to keep track of the file if it is related

to the user name, and you will only have to use one variable.

= General | (Option Detail
-Change BCC 9

-Change Quotes
Concurrent Migrations
Create Subdirectories

Date Check - Disable
-Deduping Criteria
-Display 4ll Folders
Filter Messages
MMigrate Unigue Items!
Deduping File Wirites
-Email Address Algorithm
-Empty Folder Skip
-Bxtract Email Address

Faolder Structure Only

Graup Marme

Hide Passwords

Kl

Create Separate Confact/Cale

Migrate Unique Items
Switch: /DEDUP
¥ Enabled

Parameter: Ic SfeduphgvarLdat

Migrates unique data items and stores the MOS hash value of
each message into the path and filename specified. WARNING: use
a separate file for each user.

Wiew Enabled Cptions Clear Enabled Opfions | oK |

earch

I Mext

& Custom Options

= General

- Change BCC
Change Quotes
Cancurrent Migrations
Create Subdirectories

- Date Check - Disahle

- Deduping Criteria
Display All Folders
Filter Messages
Migrate Unigue Items

- Email Address algorithm

- Empty Folder Skip
Extract Email Address
Folder Structure Only
Group Name

- Hide Passwords

|

& Custom Options []

Create Separate Contact/Cale

[ Option Detail

Deduping File Writes
Switch: /D165
¥ Enabled

Write MDS hash values to dedup file after each message, which
reduces performance but allows better recavery from
acrash,

Clear Enabled Options | oK |

Wigw Enabled Options

earch

I Mext

-1 General

~Change BCC

~Change Quotes
-Concurrent Migrations
-Creata Subdirectories

-Date Check - Disable
-Deduping Criteria
-Display All Folders
Filter Messages
Migrate Unigque Items
Deduping File Writes
Ermnail Address Algorithm
Ermpty Folder Skip
Extract Email Address
Falder Structure Only
Group Name

Hide Passwords

1

-Create Separate Contact/Cale

i

[ Option Detail

@

Deduping Criteria
Switch: /DS
¥ Enabled

Farameter: [BSDNR.

Change default deduping criteria. Used with the /DEDUP switch.
Exarnple: /OS6 BSDNR (see help file for more inforration),

Wiew Enabled Options | Clear Enabled Options | OK |

earch

I\ Mext

F = Folder

B = Message Body

D = Date R= Recipient List

H = Attachment Header (name and length)
A = Attachment Data

S = Subject
N = Sender

U —Unique ID

Note

Turn on deduping by enabling the Custom
Option Setting called, “Migrate Unique
ltems.

Add a path and filename to the
Parameter. Use an existing file or create a
new file. Use the same file if you plan on
deduping between migrations.

Enable the /D165 switch, which is titled,
Deduping File Writes. This switch forces
Transend Migrator to write the MD5 hash
value to disk immediately rather than
after the migration is over.

Optionally, enable the /D56 switch and
then modify the default value, which is
BSDNR. Add at the F value if you want to
include the message folder as part of your
deduping criteria. This might not be a
good idea if migrating from Lotus Notes
and you are migrating views and folders.
This might be a good idea if you are
migrating from another program and you
want duplicate items in different folders.
Perhaps, the folder is important.

Deduping Criteria - Use these parameters
in the Deduping Criteria switch to choose
which fields to run the MD5 Hash
algorithm against

You cannot share the dedup file with another process. Therefore, create a unique dedup file for each account migrated.
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Section 12: Command Line Processing

An alternate way of starting a batch migration is through the command line or with a batch file. Once all
Email, or Address Book, or Calendar, or Tasks sections have been set you normally begin the migration
by pressing the Start Single Migration or the Start Batch Migration button. You may also start a
migration through a command line after saving your configuration using the File | Save Configuration
As... menu choice.

1. Setup a migration project for one user or for a batch of accounts.

Load the user list if you are migrating in batch mode.

3. Save your configuration by selecting File | Save Configuration As... from the main Transend
Migrator screen. Name the configuration file and keep it short. Once have saved your settings
into a configuration file you can then run a batch migration from the command line. Review the
Command Line Syntax & Example section for the command line detail.

N

Command Line Syntax & Example

Syntax TM12.EXE /CMDL /F <path and filename>
Example TM12.EXE /CMDL /F C:\ProgramData\Transend\Project.tmd
TM12.EXE This is the Transend Migrator executable. If you run this command all by itself then Transend

Migrator will start in regular mode.

This switch tells Transend Migrator to run in command line mode. It expects the /F <filename>

/cmbL switch.

The /F switch tells Transend Migrator to perform a migration based upon the settings saved inside

/F <filename> the TMD filename specified.

Additional Options

JCONCURRENT <n> AII_ows.# of conFurrfent migrations to be set through the command line rather than using the
Migration Monitor interface.

Note

The command line must be executed from the Transend Migrator installation directory. It will be easier
to create a batch file using Notepad rather than manually running it from the command line. Below is an
example of a simple batch file:
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1. Start Transend Migrator and configure the settings for one or more accounts.

2. Save your configuration by selecting File | Save Configuration from the main Transend Migrator
screen. For this example, save your configuration file into C:\Migrate\project.tmd

3. Create a batch file and use the Batch File Example as a guide.

Batch File Example

| Batch001.txt - Notepad (=] s

‘FI|E Edit Format View Help |

gsnuffy; joe. snuffy;
johnson; bever'\%f. johnson;

balbert;blake. albert;

jkrefetz; jason. krefetz;

Jmckay; jeff. mckay;

jhieb; john. hieb;

Run the Batch File

Double-click on the batch file using Windows Explorer. Once the batch file starts it will load the
Migration Monitor and begin migration. When the migration completes the Migration Monitor will exit.

Provide accounts in CSV file

Normally, in a command line migration all your settings and account information is saved in the
Transend Migrator configuration file (TMD); however, you may save the account information inside a
CSV file and reference that CSV file. This is useful when you will be automating the user list extraction
and do not have the ability to save the user information in the TMD file. The CSV file will contain the
values for the variables you define in the TMD file. Use the /batchdata <file> switch in addition to your
other command line switch choices. Any values declared in the TMD file will be replaced, and the values
in the CSV file will be used.

Batch File Example with CSV file containing user information

TM12.EXE /CMDL 1 /F C:\ProgramData\Transend\Project.tmd /batchdata

E
xample C:\Migrate\Userlist.csv

Section 13: Migration Monitor

The Migration Monitor displays the real-time status of all user mailboxes as they are migrated. The
Migration Monitor is a multi-threaded process, which means that multiple accounts can be migrated at
the same time if the email systems support concurrent migrations, and if your license permits.

SE]

Datsase e Currerh Task  Folers | CLrrend Fakder e ol Progess  Etes  Ebyfogess Al K

[ —— R [ s o

e SruffyDmcpter.., Eml 3 b i e - EEm 0
- me [ = o

o St Dephor.. Email 10 Hmen rescurces.

Increase the number of
concurrent migrations to
improve throughput

]
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Section 14: Concurrent Migrations

Transend Migrator has the ability to migrate more than one account at a time, and this is called
Concurrent Migrations. During a batch process, Transend Migrator will migrate each account in entry
order, which is defined in the Batch Mode Data table. It starts at the top and works through the list until
the list is complete. If your license allows, you may migrate more than one account at a time. This allows
you to complete your project more quickly.

Adjust the number of concurrent migrations when you begin a migration and the Migration Monitor
appears. Transend Migrator will default to 1 concurrent migration. Press the up or down arrow to adjust
the number of concurrent migrations.

Performance

Increase the number of concurrent migrations to attain the best possible speed your system will allow.
Each computer system is different, and each email system is different. Migrating data on a local machine
gives you one rate of speed, while migrating across a local area network will give you a different rate of
speed. The number of email messages and attachments will also affect your migration rate, as will the
size of those messages and attachments.

The best way to determine how fast you can perform a migration is by setting up a few test accounts
and giving each account 1 Gigabyte of normal email data. Migrate one account at a time and review the
rate of speed. Then, migrate the same test accounts and increase the number of concurrent migrations
to 2, and so on. Evaluate the rate of speed and the combined rate of speed. Lower the number of
concurrent migrations when you see a decrease in migration rate

Adding Migration Workstations

At some point, you will reach the maximum capability of your migration workstation, and you may want
to add more workstations to decrease the amount of time it takes to migrate your accounts. Review
how long it takes to migrate 1 GB of data on a single workstation, determine the number of concurrent
migrations your workstation will allow, and then calculate how much faster your project will complete
by adding workstations.

Calculating Migration Time

Below are examples of an easy way to calculate how long it will take to complete a migration. Create a
simple spreadsheet that lists the total number of gigabytes to migrate, the quantity of workstations you
will use, and then the rate of speed your system will migrate. Then, enter a simple formula to calculate
how long your migration will complete with one workstation. In these screenshot examples, your
formula would be: ((Gigabytes/Rate)/PC’s).
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In Microsoft Excel, your formula would look similar to: =(E14/E16)/E15

Number of Days 4.86

Spreadsheet Example 1
| |
! | Item |Description Value !
I e1s 3 Total Quantity of Datato Migrate in Gigabytes 350 !
jet5 4 Quantity of PC's to Process the data 1 i
| B8 5 Gigabytes per Hour 3 |
i Processing Time For Completion In Hours 116.67 |
i

In the spreadsheet example above, it will take 4.86 days to migrate 350 gigabytes of data at the rate of 3
gigabytes per hour. Therefore, you may want to add more machines to complete your project in a
shorter amount of time.

Number of Days 0.97

Spreadsheet Example 2

i i
! | Item |DE§|:riptiun value !
[ 3 Total Quantity of Datato Migrate in Gigabytes 350 [
i 4 Quantity of PC's to Process the data 5 i
| 5 Gigabytes per Hour 3 |
i Processing Time For Completion In Hours 23.33 i
| |

If you are using a simple formula, add more workstations to your spreadsheet to determine how much
faster your project will complete. In Spreadsheet Example 2, the same migration will complete in 23
hours if 5 workstations are used at the same time. Be careful when adding computers to your project,
and verify your source/target servers and network can handle the workload. In you are migrating into
Microsoft Exchange, we recommend you turn off Transaction Logging so that your Exchange Server will
not become overloaded and use up too much disk space. Turn Transaction Logging back on when your
migration project is complete.

Section 15: Schedule Migration

You may schedule a migration to begin at a later time by setting the start time on the Migration
Schedule screen. Start later in the evening when you can receive optimal performance, bandwidth, and
no interruption. If there are other processes that must begin while the migration is running then you
may also pause the migration, and continue after the processes are complete.

You must configure your migration before you can schedule it. Pre-configure the E-Mail, Address Book,
Calendar, and Tasks as they need to be set. Import your list of users if performing a batch migration, and
then save this configuration by selecting File | Save Configuration from the Transend Migrator main
menu.

Caution
Once the schedule has been set it will become effective and begin only after pressing one of the Start

Migration Buttons. Migration will not happen if you close Transend Migrator.

You do not have to set all options in the Migration Schedule. Only the values with an enabled checkbox
will take effect after pressing the Start Migration Button.
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Section 16: Reporting / Logging

Reporting

Migration reports in XML format will be created after each successful run, and can be viewed with
Microsoft Excel. XML reports can be found inside the default subfolder or in a folder containing the
name of the custom configuration, and can easily access by selecting View | Migration Reports from the
main menu. Each time a migration is run a new Migration Report will be created, and it will be assigned
an incremental number beginning with the number 1.

A B C D E F G H | J K
User D Status Database/User Time Started Time Ended Elapsed Time Folder Count Email Count Address Count Calendar Count Task Count
1 Completed pdeex!ljoe snuffy 2/2/3011 18:26:56 2/2/2011 18:28:35 00:01:40 23 1731 1} ] 0
2 Completed pdeex!ljenniferjones  2/2/2011 18:27:38 2/2/2011 18:28:57 00:01:19 23 575 i} 0 i]
3 Completed pdcex!!john.smith 2/2/2011 18:27:39 2/2/2011 18:28:59 00:01:20 16 605 i} 0 i]
4 Completed pdcex!!beverlyjohnson 2/2/2011 18:28:37 2/2/2011 18:28:57 00:00:20 50 91 i} 0 i]

Totals: 112 3002 o i} i}

ol oo e w e

The default detail contained within the XML Report contains the following information:

e UserID e Status

e Database / User ¢ Time Started

¢ Time Ended ¢ Elapsed Time

¢ Folder Count ¢ Email Count

¢ Address Count ¢ Calendar Count

¢ Task Count e Attachment Count

¢ Skipped Entries e Data Rate (megabytes per hour)

Use the following switch and value to increase or decrease the level of detail in the XML Report:

Switch Value Description

Use this switch to disable XML reporting. No XML report will be produced when

/NOXMLREPORT this switch is used.

Use this switch and value to determine the level of detail recorded into the XML
/XMLREPORTLEVEL <n> report. The default value is 1. Increase the value to 2 if you want to record Folder
Names and Entry Counts for those folders.

Note

Transend Migrator reports the number of attachments converted with each message; however please
be aware that this number may include graphic images embedded within HTML documents. Therefore,
the number of actual attachments visible in your email client, such as Word or Excel files, may be
different than reported.
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Logging

Transend Migrator will create a master log file named tmlog.htm! inside the default system directory.
This log file contains detailed information about the migration session. User specific log files will be
called Tmlog-#.html. The number # will correspond with the specific job number for that user as found
in the Migration Monitor. This file contains detailed information about a specific user. Since the log files
are HTML they are viewable by using your Internet browser. If you want text based log files then use the
JLTEXT switch option located inside the Log File section in Custom Options.

You can find the log files inside one of the following system directories:

Windows XP C:\Documents and Settings\All Users\Application Data\Transend

Windows Vista
Windows 7, 8
Windows 2008 R2

Windows 2012 R2 C:\ProgramData\Transend

Each time you migrate an account, Transend Migrator will create a user specific log file inside a
subdirectory from one of the two system folders listed in the above table. This subdirectory will be
called default, which is the same name as the default configuration TMD file containing all of the
settings and options used in the user interface. If you create custom configuration files the subdirectory
containing user log files will be given the custom configuration’s name rather than default.

The following switches are available to change the way Transend Migrator records information inside
the user specific log files.

Switch Description

JLAP This switch tells Transend Migrator to append to the existing log file instead of creating a new one on
each run.

JLL Use this to create a Summarylog.txt file.

/LNO Use this switch to disable logging. Creating a log is enabled by default.

/LSUB If enabled, each message converted will have its subject added to the log file.

JLTEXT Use this switch to create text log files instead of HTML log files.

/LTS Adds a timestamp value to each line in the log file.
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Section 17: Troubleshooting

General Logon Errors
There are four possible error messages you may receive when attempting to log on to your email
system.

1. Invalid user name or ID: This error generally appears only for IMAP, Outlook, and GroupWise.
Check that you have entered the correct user name, including case and spelling.

2. Invalid password: As above, generally this will occur only with IMAP, Outlook or GroupWise.
Check the spelling, punctuation, and case.

3. Invalid database or directory: This error can occur for systems where it is necessary to identify a
directory where email files may be found. This would include Netscape, Eudora, cc:Mail
archives, EML, and Web. It can also occur for systems where you have to identify a specific
database file, such as a Lotus Notes .nsf file. For Notes, the file must exist in a readable
directory. For the other systems mentioned, assuming that the directory itself exists, the
program is checking for the presence of specific files. For example, the Netscape directory must
have at least one .snm or .msf file. The Eudora directory must have a .mbx file, and the Pegasus
directory must have a .pmm file.

4. Unable to connect with mail system: This is a generic error that can indicate a variety of
problems. Close Transend Migrator and verify the connection with your email client. Use those
same settings when migrating email data with Transend Migrator.

Usually more information is available about a logon problem in the log file. If the error message in the
log file is not helpful, please send a copy to our technical support for further analysis.

Antivirus and Spam Filters

If you have viruses in your email then your antivirus or spam filter might intercept those viruses during
migration. Therefore, it is best to clean your email before or after performing a migration. If the
message is intercepted during migration it could interfere with a successful migration.

If you have antivirus and spam prevention software running on your source or target server, and even
the workstation performing the migration, you will slow down the amount of time it takes to migrate
your data. To improve performance and to decrease the amount of time it takes to migrate your data
turn off antivirus or spam filtering software. Any software designed to intercept email traffic will impede
performance.

Application Violations
These errors can be difficult to troubleshoot but are mostly related to corrupted email messages, or files
that are not email messages but you tried to convert them. If the latter is the case then remove the
offending file.
1. If an application violation (AV) happens then make note of the folder the problem happened in.
2. Enable the /LSUB switch option for logging. The /LSUB switch option will log each message
subject converted (or attempted) into the log file.
3. Attempt an isolated conversion of that specific folder. When the AV happens close Transend
Migrator.
4. Open the Log File with Notepad or alternate text editor.
5. Make note of the last message converted. This will tell you where to look for the problem.
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6. Open the source message account and search for the message subject causing the AV.

Move that message into a TEMP or SAVE message folder.

8. Optionally, move the next message into the same TEMP or SAVE folder. Quite often, it was not
the last message converted that caused the AV. It could be the next one in line. Therefore, this is
why you need to move the next one into the TEMP or SAVE message folder.

9. Begin another migration, but this time skip the TEMP or SAVE message folder. When the
migration is successful you can continue on. You will have successfully identified the corrupted
or problem messages.

N

Microsoft Outlook

Microsoft Outlook must be the default email system for Windows when migrating Outlook email data.
At least one profile must be created so that Outlook will set itself up for your email environment. Once
this is done then no other profiles are needed if using the special syntax to access accounts directly.

You do not need a profile to migrate multiple Exchange accounts. Profiles are not required. But, your
Windows account must have permissions to access the account you are accessing. Contact your
Network Administrator to gain access to other people’s email accounts. If you are performing migrations
for selected Exchange users then you must be granted RECEIVE-AS permissions on the mailbox to be
migrated.

When you are using the Transend Migrator graphical User Interface you can migrate other people’s
email accounts as long as you have created a profile for that user, and have the login ID and password
for that user. This is not the recommended method. The recommended method is to be granted access
permissions so that a password is not needed and so that a profile is not needed.

If you are migrating multiple users and/or will be using the Batch Mode Processor then give your

Windows account (the account or group doing the migration) the RECEIVE-AS permissions on the
Mailbox Database for your Exchange Server.
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Section 18: Technical Support

Technical support is available to help you understand how to use Transend Migrator with your migration
project. Please review the Help File and online resources before contacting technical support.

You are encouraged to submit questions through email. This will allow us time to properly research your
situation and make appropriate recommendations.

Note: Transend’s normal business hours are M-F, 9am — 5pm (Pacific). If you will be performing a
migration during non-business hours, and anticipate a need for support during non-business hours,
please contact us at least 7 days in advance so we can schedule a support engineer to be available, if
possible.

Sending Log Files to Transend Technical Support

It is important to include a copy of your log files when submitting a support request. You may send the
log files individually, or send the log files using the Email Log Files menu feature from the Transend
Migrator interface using the following procedures:

“\ProgramData\Transend\default.tmd

Contents /
viail g Address Bou Email Log Files 5
About..
E-Mail Configuration | Enable Migration

— Taroet

Select Help>Email Log Files from the menu list. Transend Migrator will attempt to open your default
email program and then create a new message similar to the example, below.

4 To... tech.suppor tStr ansend.com
SE08, e

Account = | Subject: | Transend Migrator log files from Johin Hieb/Transend Corporation

IMPORTANT: you must manually attach this file:
C:\Users\john. hieb\Decuments\Transend_Logfiles.zip |

Enter any further information below:

Notice

The path to the log file package (a zip file containing your log files, report, and settings file) will be
inserted into the body of the email message. In the example, the log file path and filename is at
C:\Users\john.hieb\Documents\Transend_Logfiles.zip. Your path will be similar. Using your email
program, insert the log file package. Use the path and filename listed in your email message.

Before contacting technical support, we recommend that you are using the current patches or service
packs for your hardware, your operating system and software. Also, download the latest version of
Transend Migrator from www.transend.com. Review the What’s New section of the Transend web site
to review the latest release information.

Email: tech.support@transend.com.
Phone: (650) 324-5370
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